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Software AG IDL Extractor for PL/I

The Software AG IDL Extractor for PL/I extracts a Software AG IDL file from a PL/I source. The
PL/I source can be located in the file system or accessed remotely within a PL/I RPC environment
definition.

Using Describes how to use the Software AG IDL Extractor for PL/I.

RPC Environment Manager Using the RPC Environment Manager to create, edit and remove RPC
environments.

RPC Environment Monitor using the RPC Environment Monitor to check the availability of each RPC

environment.
Command-line Mode Describes how to use the IDL Extractor for PL/I in command-line mode.
PL/I to IDL Mapping Describes the subset of PL/I data types that can be mapped to Software AG
IDL data types.




vi



1 Using the Software AG IDL Extractor for PL/I

= Extracting Software AG IDL File from Local PL/I Source File ...........covvviiiiiiiiiiiiii e 2
= Extract Software AG IDL File from a Remote PL/I RPC ENVIFONMENT ....covvvneieee e 6
B EXITACHON ROSUI ... e e e 12

12

= Preferences ......




Using the Software AG IDL Extractor for PL/I

This chapter describes how to use the IDL Extractor for PL/I.

Extracting Software AG IDL File from Local PL/l Source File

= Start the Wizard
= Select a Source
= Select the File Container

Start the Wizard

Start the IDL Extractor for PL/I Wizard. When the PL/I source file to extract is available in your
workspace and you have selected it, the file location will be entered in the wizard automatically.
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Using the Software AG IDL Extractor for PL/I

Select a wizard
Exkract a new Software &G IDL File from PLIT

YWizards:

|I:~;.f|:|e Filter bext

= Java
= Plug-in Development
== Software AG
E Web Services Stack Packaging Wizard
=-[= Entirex
-ﬂ Entirel Web Service Project
E 101 Extractor For COBOL
EF IDL Extractor for Matural
H] IDL Extrackor For PLJT
P 101 Extractor For WSOL
H! IDL Exkractor For #ML Document
@ IDL Extractor for ¥ML Schema
[ Software AG IDL File
= User Assistance

Select a Source

Select Use local File System or existing RPC Environment, choose File and press Next.
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Using the Software AG IDL Extractor for PL/I

& IDL Extractor for PL/I

Select a Source -
The Software 4G IDL File will be extracted from the selected PLIT Source, *

This Wizard will help wou ko extract a Software &5 IDL File from a specified PLJT Source, The PLJT
Source can be located in the local File System or can be accessed remotely via a so called RPC
Environment,

{:} Create a new RPC Environment

(*) Use local File System or existing RPC Environment:

|

(= ibmz: 3762 @RPCPLIEXTRACTOR

®

If you selected the PL/I source file before you started the wizard, the file location is already present,
otherwise press Enter or click Browse for the PL/I source file.

& IDL Extractor for PL/I

Select a Source

The Saftware &3 IDL File will be extracked From the selecked source,

Eile Marme: |
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Using the Software AG IDL Extractor for PL/I

Select the File Container

Select the Container where the Software AG IDL file will be stored. Enter the File Name of the
new IDL file.

The following rules apply to the Extraction Settings:
® The Source Type must match the PL/I programs you are extracting, otherwise extractions fails.

Adjust the source type in the Preferences; see Preferences.

® For the source type IMS, optionally IMS-specific PCB pointers can be provided in a so-called
PSB List in the field File containing PSB List. See PSB List. The IDL Extractor for PL/I then
marks these parameters with the IMS attribute. See attribute-11st under Software AG IDL
Grammar in the IDL Editor documentation. This is required to create RPC clients correctly calling
IMS BMP programs with PCB pointers successfully.

7= IDL Extractor for PL/I

Select a File Container

The Saftware &5 IDL File will be extracted inka the selected File Cantainer.

Container: *| IPLIE=kractor

File Mame: *| CALC

Extraction Settings

Source Tvpe | EATCH

File containing PSE lisk: |

© o=

Press Finish to extract. For more information see Extraction Result.
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Using the Software AG IDL Extractor for PL/I

Extract Software AG IDL File from a Remote PL/I RPC Environment

This section covers the following topics:

= Start the Wizard

= Select an RPC Environment

= Create RPC Environment (Optional)
= Select Data Set (Optional)

= Select Source and Extract

Start the Wizard

Start the IDL Extractor for PL/I Wizard.

Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

Select a wizard
Exkract a new Software &G IDL File from PLIT

YWizards:

|I:~;.f|:|e Filter bext

= Java
= Plug-in Development
== Software AG
E Web Services Stack Packaging Wizard
=-[= Entirex
-ﬂ Entirel Web Service Project
E 101 Extractor For COBOL
EF IDL Extractor for Matural
H] IDL Extrackor For PLJT
P 101 Extractor For WSOL
H! IDL Exkractor For #ML Document
@ IDL Extractor for ¥ML Schema
[ Software AG IDL File
= User Assistance

Cancel

Select an RPC Environment

Select Create a new RPC Environment and press Next if no RPC environment exists or you want
to create a new RPC environment. Continue with instructions under Create RPC Environment
(Optional).

Select Use local File System or existing RPC Environment, choose the RPC environment from
the list below and press Next. Continue with instructions under Select Data Set (Optional).
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Using the Software AG IDL Extractor for PL/I

& IDL Extractor for PL/I

Select a Source
The Software &G IDL File will be extracted from the selected PLJT Source,

This Wizard will help wou ko extract a Software &G IDL File from a specified PLJT Source, The PLJT
Source can be located in the local File System or can be accessed remotely via a so called RPC
Environment,

{:} Create a new RPC Environment

(*)Use local File System or existing RPC Environment:

L File
[ ibmZ 3762 @RPCIPLIJEXTRACTOR

Zancel

Create RPC Environment (Optional)

The connection to the Extractor Service to browse for PL/I programs is defined on the RPC Envir-
onment page. See Extractor Service.

In the Broker Parameters, required fields are Broker ID and Server Address, which have the default
format "brokerID@serverAddress". The given Timeout value must be in the range from 1 to 9999
seconds (default: 60).

The EntireX Authentication describes the settings for the Broker, the RPC Server Authentication
the settings for the RPC Server.

The following rules apply to the Extractor Settings:

® A high-level qualifier is required in the Data Set Name or HLQ field. The Extractor Service will
then offer only data sets with this high-level qualifier.

® In the Member Name field you can provide a prefix for the partitioned data set or CA Librarian
members. The Extractor Service will then offer only members beginning with this prefix.

8 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

= IDL Extractor, for PL/I

. .
New RPC Environment R
Define a new RPC Environmeant,
Broket Parameters
Broker ID: *l localbost: 1971 |
Server Address: ' RPC/SRY1/CALLNAT | [Et...

Timeout (Seconds): | ) |

Enkirel Authentication RPZ Server Authentication
UserTD: | | mecuserim: | |
Passward: | | RPC Password: | |

Extractor Settings
Enter names, or use filter For range of values (wildcards * and 7 on any position, < and = as final characker anly).

Data Set Hlame: | ET5.% |

Wrapper Settings

Save locally

Save remokely

Ervvironmment Marme
(O Defaulk flocalhost: 197 1 @RPCISAY L/ CALLNATY

(®) other: | localhost: 197 L@RPC/SRYLJCALLMAT

® [ < Back. “ Mext = ] Finish

The RPC environments are managed in the Preferences. See RPC Environment Manager.

Select Data Set (Optional)

The following page offers all data sets starting with the high-level qualifier defined in the Filter
Settings of the remote PL/I RPC environment. Select the data set from the list and press Next.
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Using the Software AG IDL Extractor for PL/I

& IDL Extractor for PL/I M=
i
Select a Source -
The Software &G IDL file will be extracted from the selected source.
Datasek;
Mame

ENTIRE®.PLI. SERYER. . DFHSRICE
ENTIREX.PLI, SERVER., MWSLOAD
ENTIRE®.PLI. SERYER. . MYS5RICE

Tokal: 3

Cancel

Select Source and Extract

In the Source pane, select at least one PL/I file from the Member list. The buttons on the right allow
you to Select All or Deselect All members from the list.

The following applies to the Extraction Settings pane:

The Source Type must match the PL/I programs you are extracting, otherwise extractions fails.
Adjust the source type in the Preferences; see Preferences.

For the source type IMS, optionally IMS-specific PCB pointers can be provided in a so-called
PSB List in the field File containing PSB List. See PSB List. The IDL Extractor for PL/I then
marks these parameters with the IMS attribute. See attribute-1ist under Software AG IDL
Grammar in the IDL Editor documentation. This is required to create RPC clients correctly calling
IMS BMP programs with PCB pointers successfully.

In the Target (Eclipse Workspace) pane, select the Container where the IDL file will be stored.
Enter the name of the new IDL file.

10 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

7= IDL Extractor for PL/I

Select a Source =
The Software AG IDL file will be extracted from the selected source, =)
Source (PLIT)
List of members from data set EMTIREX, QE.PLL, SR.CE:
Marme Created Modified Records A0 Select Al
_aLc 2004-09-16 2004-09-16 15:23 44
[] cops#ru 2005-11-21 2005-12-05 16:59 18 | | Deselect Al
[] oEFaULT
EXAMPLE 2005-11-17 2005-11-21 12:15 26
D EXLIP#L 2005-01-16 2005-01-16 13:26 o5
|:| ExLP#Z 2006-01-16 2006-01-16 14:04 it K
[ i 4 A 4 4 44 s bt
Tokal: 122
Extraction Setkings
Source Type | BATCH
File containing PSE lisk: | |
Target (Eclipse Warkspace)
Conkainer: | "PLIE=tractar | |Eir|:|ﬂse...
File Mame: | ENTIREX.QE.PLI, SRCE |
[[]save selected sources lacally on Finish
® [ Einish l [ Zancel

Press Finish to extract. For more information see Extraction Result.
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Using the Software AG IDL Extractor for PL/I

Extraction Result

When the operation is completed, the IDL file is opened with the IDL Editor.

If the PL/I source contains IMS-specific PCB Pointers as described in the IMS RPC Server document-
ation, the extracted IDL contains those pointers marked with the attribute "IMS" see attribute-
1ist under Software AG IDL Grammar in the IDL Editor documentation. As a preceding step, use
the PL/I Wrapper to generate server interface object(s) and provide them to the IMS RPC Server.
See Using the PL/I Wrapper for IMS BMP.

If the PL/I source file contains parameters that cannot be mapped to IDL parameters, an IDL file
with incorrect IDL syntax is created. The unsupported parameters lead to IDL parameters of data
type "Error", which is not supported. The Problems View of the PL/I source file contains markers
for all unsupported parameters.

Preferences

The preference page for IDL Extractor for PL/I manages the default values for the IDL Extractor
for PL/I Wizard.

The following applies to the Extraction Settings pane:

® The Source Type must match the PL/I programs you are extracting, otherwise extractions fails.
Adjust the source type in the Preferences.

® For the source type IMS, optionally IMS-specific PCB pointers can be provided in a so-called
PSB List in the field File containing PSB List. See PSB List. The IDL Extractor for PL/I then
marks these parameters with the IMS attribute. See attribute-1ist under Software AG IDL
Grammar in the IDL Editor documentation. This is required to create RPC clients correctly calling
IMS BMP programs with PCB pointers successfully.

12 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

| 7= Preferences |:|@

| | | IDL Extractor for PL/I -

Java F'e.r5|stence - The PLJI preferences are used ko extract IDL Files From PLJT source.

Jawascripk ] .

Flug-in Development Extraction Settings

Report Design Source Type: |B.ﬁ.TCH hd

Fun/Debug

Server |

= Software AG

=) Entiret The PL{I RPC environments are managed on the Preferences page 'RPC Environments',

MET \Wrapper
 Wrapper
COBEOL Wrapper
Cuskom \Wrapper
DiZ M WYrapper
Deplovment Environmer
EJE Wrapper B
I0L Extractor for COBO
IDL Extractor For Makur:
IDL Extractor for PLT
I0L Extractor For WabL
Installakion
Integration Servers

< Toeos Mmoo | @ lRestnre Defaults ] [ Apply ]

® [ O ] [ Cancel ]

Software AG IDL Extractor for PL/I 13
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2 Using the IDL Extractor for PL/l in Command-line Mode

= Command-line Options

= Example ....vvviiinnnns
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Using the IDL Extractor for PL/I in Command-line Mode

Command-line Options

See Using the EntireX Workbench in Command-line Mode for the general command-line syntax.

Task Command Option Description
Extract |-extract:pli|-brokerpassword|Password used for broker authentication.
the PL/I -brokeruser User used for broker authentication.
source
objects -environment Name of the environment or an RPC server description.
from an -filter Filter the PL/I source objects. Show those objects which
RPC match the pattern.
Extractor -help Display this usage message.
Service. -
-ims Name of the file with the names of the IMS psb parameters.
-project Name of the project or subfolder where the IDL file is stored.
-rpcpassword Password used for RPC server authentication.
-rpcuser User used for RPC server authentication.
-source A PL/I source object in the environment.
Listthe [-Tist:pli -brokerpassword|Password used for broker authentication.
-brokeruser ser used for broker authentication.
PL/I brok U d for broker authenticati
source
objects -environment Name of the environment or an RPC server description.
on an -filter Filter the PL/I source objects. Show those objects which
RPC match the pattern.
Extractor -help Display this usage message.
Service.
-rpcpassword Password used for RPC server authentication.
-rpcuser User used for RPC server authentication.
-source A PL/I source object in the environment.
Example

<workbench> -extract:pli -environment pliBroker:2006@RPC/PLISRVI/EXTRACTOR -project «
/Demo -source PLI.DATA.SET -filter PLISRCI

where <workbench> is a placeholder for the actual Workbench starter as described under Using
the EntireX Workbench in Command-line Mode.

The extracted Software AG IDL file will be stored in the project Demo.

If the environment name is not a defined RPC environment in the current workspace, the name
will be interpreted as a Broker ID and RPC server address (brokerID@serverAddress).

16
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Using the IDL Extractor for PL/l in Command-line Mode

The source specifies a data set name and the optional filter defines the member name. Simple
wildcard notation with an asterisk (*) can be used at the end of these names.

Status and processing messages are written to standard output (stdout), which is normally set to
the executing shell window.

Software AG IDL Extractor for PL/I 17
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3 PL/I to IDL Mapping

= DL Extractor for PL/I Input

B DL EXtractor for PLI QUIPUL ...ttt
= Mapping PL/I Data Types t0 SOftware AG IDL ........ccouiiiiiiii e

B FUNctionsS .....oovvvevvieeannn,
m Structures .........ooevvvennen..

= Aligned ..o,
= PL/l to IDL Restrictions .....
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PL/I to IDL Mapping

This chapter describes how PL/I data types, their attributes and related syntax are mapped to
Software AG IDL data types by the IDL Extractor for PL/I.

IDL Extractor for PL/I Input

PL/I'source code is the input for IDL generation. The IDL Extractor for PL/I inspects the parameter
definition of PL/I procedures or PL/I functions and their DECLARE statements.

The sources

" must contain external PL/I procedures or PL/I functions;
" must be free of preprocessor statements;

® must be compiled with no errors and no warnings.

IDL Extractor for PL/I Output

The IDL Extractor for PL/I generates:

* the Software AG IDL file name by adding the extension “.idl” to the PL/I source file name without
extension;

® the Software AG IDL library name from the PL/I source file name without extension;

= the Software AG IDL program name from the name of the PL/I external procedure or function.

Mapping PL/I Data Types to Software AG IDL

The IDL generator maps the following subset of PL/I data types to IDL data types, other PL/I data
types as transfer parameters are not supported. If the PL/I source file contains parameters which
cannot be mapped to IDL parameters, an IDL file with incorrect IDL syntax will be created.

The following metasymbols and informal terms are used for the Software AG IDL in the table
below.

® The metasymbols [ and ] enclose optional lexical entities.

® The metasymbols ( and ) enclose numeric expressions which must be evaluated.

* The informal term n and m is a sequence of numeric characters, for example 123.

The metasymbols * and / represent a numeric expression which must be evaluated for the real
number.

20 Software AG IDL Extractor for PL/I



PL/I to IDL Mapping

PL/I Data Type Software AG IDL | Description Notes
CHARACTER (m) An Alphanumeric 1
CHARACTER (*) AV Alphanumeric variable length

CHARACTER (n) VARYING|AVn Alphanumeric variable length with maximum length |1
GRAPHIC (n) K(n*2) Kanji fixed length 2
GRAPHIC (*) KV Kanji variable length

GRAPHIC (n) VARYING [KV(n*2) Kanji variable length with maximum length 2
BIT (m) B(n/8) Binary 3
BIT (*) BV Binary variable length

FLOAT BINARY Fa4 Floating point (small)

FLOAT BINARY (21)
FLOAT DECIMAL
FLOAT DECIMAL(6)

FLOAT BINARY (53) F8 Floating point (large)
FLOAT DECIMAL (16)

FIXED BINARY Il Integer (small)

FIXED BINARY (7)

FIXED BINARY (15) 12 Integer (medium)

FIXED BINARY (31) I4 Integer (large)

BIT L Logical

BIT (1)

PIC 'SCmILV(mMI9l’ NmC.n] Unpacked decimal

PIC "(mILV(mMI91" NUmL . n] Unpacked decimal unsigned
FIXED DECIMAL (m,n) |P(m-n)[.n] |Packed decimal 5
| Notes:

. nis the number of graphic characters (DBCS).

. nis the number of DBCS characters.

1
2
3. nis the number of bits and n must be a multiple of 8.
4. m,n, are numbers, where n <=7, n<=29 and m+n <=29.
5

. m,n, are numbers, where n <=7 and m <= 29.
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PL/I to IDL Mapping

Functions

The function return value of a PL/I external function will be mapped to an additional parameter
“Function_Result” with the direction out; this parameter will be appended to the last parameter
of the procedure.

For example, the external function R_CHAR

R_CHAR: PROCEDURE (p) RETURNS ( CHAR (20) )
PUT SKIP LIST('R_CHAR $dollar;:Revision: n.n $');
DCL p CHAR(10);
RETURN (p);

END R_CHAR;

will be mapped to the Software AG IDL program:

program 'R_FLOAT" is
define data parameter
1p (F4) In Out
1 Function_Result (F4) OQut
end-define

Structures

Structures are mapped to Software AG IDL groups. Asterisks as fillers or reserved items are not
supported.

declare 1 Payroll,

2 Name,
3 Last char(20),
3 First char(15),
2 Hours,
3 Regular fixed dec(5,2),
3 Overtime fixed dec(5,2),
2 Rate,

3 Regular fixed dec(3,2),
3 Overtime fixed dec(3,2);

will be mapped to Software AG IDL

22 Software AG IDL Extractor for PL/I



PL/I to IDL Mapping

1 Payroll In Qut

2 Name
3 Last (A20)
3 First (A15)

2 Hours
3 Regular (P3.2)
3 Overtime (P3.2)

2 Rate
3 Regular (P1.2)
3 Overtime (P1.2)

Arrays

Arrays are mapped to Software AG IDL arrays. The dimension of an array is restricted to 3.

DCL A CHAR(10) DIMENSION (100);

DCL B CHAR(C10) DIMENSION (*);

DCL C CHAR(10) DIMENSION (-5:10);
DCL D CHAR(C10) DIMENSION (10,10,10);

will be mapped to

1 A (A10/100) In Out
1 B (A10/V) In Out
1 C (Al0/16) In Out
1 D (A10/10,10,10) In Out

Aligned

The ALIGNED attribute will be mapped to the Software AG IDL attribute aligned. See attribute-
11st under Software AG IDL Grammar in the IDL Editor documentation.

PL/I to IDL Restrictions

The following table lists features, clauses and items that are not supported by the IDL Extractor
for PL/I:

Software AG IDL Extractor for PL/I 23



PL/I to IDL Mapping

ltem

Description

PL/I Preprocessor

MACRO preprocessor for PL/I source program alteration. It is executed prior to
compilation

UNALIGNED attribute

The UNALIGNED attribute reduces to one byte the alignment requirements for
halfwords, fullwords, and doublewords and it reduces to one bit the alignment
requirement for bit strings.

24
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4 RPC Environment Manager

The RPC environment is managed on the RPC environment preference page. The RPC environments
can be created, edited and removed. There are several types of RPC environment: Natural, PL/I
and XML/SOAP. The RPC environment type will be used to prepare the selection lists of the fol-
lowing wizards:

® Natural RPC Server

® IDL Extractor for PL/I

= XML/SOAP RPC Server
Use the RPC Environment Monitor to check the availablity of each RPC environment.

Using these wizards, you can add new RPC environments of the respective type. To manage these
RPC environments, open the Preferences page.

25



RPC Environment Manager

& Preferences

|type Filker text | RPC Environments Ll v

= Software AG 1| Manage the RPC Environments For XML{SOAP RPC Server, Natural RPC Server and IDL Extractar for PLJL,
Ajax Developer

Application Modeler Table of defined RPC environments:

Business Services Marne Broker ID Server Address [lnsert... ]
Code Generation =N i
Falocalhost, 197 L@RPCMNATSRYZ2B00{CALLNAT localhost, 1971 RPC/MATSRYZE00/CALLNAT ¢

(=) Entires Era :
libroker :197 | @RPC/PLISRYL/CALLMAT libroker: 1571 RPCIPLISRYL/CALLNAT
MET Wirapper T plibroker @RPCS f plibeoker i §

C Wrapper
COBOL Wrapper
Cuskom Wrapper
DCOM Wrapper
Deployment Environments
EJB ‘Wrapper
I0L Extractor For COBOL
10L Extractor for Matural
I0L Extractor for PLIT
0L Extractor for WSDL
Installation
Inkegration Servers
Java \Wrapper
Matural Wrapper
PLJI Wrapper
RPC Environments
Web Service Wrapper
¥ML Mapping Editor
Tatural
UDDI Registries
‘Web Services Stack -

@ Ok ] [ Cancel

To edit an existing RPC environment, select the table row and press Edit.... If multiple entries are
selected, the first entry is used.

To remove an RPC environment, select the table row and press Remove. You can select multiple
environments.

To create a new RPC environment, choose Insert....

26 Software AG IDL Extractor for PL/I



RPC Environment Manager

7= RPC Environments |;|®
.

New RPC Environment pu
Define a new RPC Environmeant,
Type: |Matural RPC Server v |

Broker Parameters
Broker 1D Rlocahosti 1971 |
Server Address: | RPC/SRVLICALLNAT | [Edt...

Timeaut (Seconds): | ] |

EntireX Authentication RPC Server Authentication
User ID: | | mPCUsermm: | |
Password: | | RPC Password: | |

Extractor Settings
Enter names, or use filker for range of values (wildcards * and 7 on any position, < and = as final characker only).

Libraty Marne: | |

Program Marme: | |

‘Wrapper Settings
() Save locally
() Save remately

Environment: Mame
() Default

(%) Other: | Matural RPC Server

® [ Finish H Zancel ]

Choose the Type and enter the required fields: Broker ID, Server Address and a unique Environ-
ment Name, which will have the default format brokerID@serverAddress. The given Timeout value
must be in the range from 1 to 9999 seconds (default: 60).

EntireX Authentication describes the settings for the broker, and RPC Server Authentication
describes the settings for the RPC server.

The Extraction Settings are used for the IDL Extractors (Natural and PL/I) only. Use them to
specify the name of the Dataset/Library and the Member/Program name.

The Wrapper Settings are used for Natural Wrapper only, and you can specify the operation type
and target library name (not available for Save locally).

Software AG IDL Extractor for PL/I 27
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5 RPC Environment Monitor

The RPC Environment Monitor is part of the EntireX Workbench. It is an Eclipse view that provides
a quick overview of the availability of the defined RPC environments in your workspace.

» To open the RPC Environment Monitor from the EntireX perspective

s Choose Window > Show View > RPC Environment Monitor.

» To open the RPC Environment Monitor from a non-EntireX perspective

= Choose Window > Show View > Other > Software AG > RPC Environment Monitor.
The RPC environments are managed on the Preference page. See RPC Environment Manager.
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Table of defined RPC environments:

Mame EBroker ID Server Address Skatus
:'jp Java RPC Server E localhost:1971 @ RPC/SRYIJCALLNAT Broker Error 0007 0007; RPC/SRYLMCALLMAT not registered
M patural RPC Server @ localhost: 1971 B RPC/MATSRY2800/CALLMAT  Matural RPC Server 6,3,4.4 on WHNT-£86 (NATE311.0)
E‘E ®MLISOAP RPC Server @ localhost: 1971 @ RPC/XMLSERYER/CALLMAT  Entired %ML RPC Server 5.2.2.0.162 Windows =P 5.1 x86,

The status check starts when the view is opened. To force an additional check, choose Refresh
from the Views toolbar. The status check can be cancelled in the dialog that appears or within the
Eclipse progress view. When the check is complete or if it cancelled, the following symbols indicate
the status of the corresponding item. The table will be reloaded every time a status check is started
to make sure all stored RPC environments are available.
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Symbol | Status

| Running.
e Not running.
E4AN

Unknown (at the beginning of the check or if the check was cancelled).

| Note: Additional status information (including error messages) is displayed when refreshing
the view (by a ping command to all specified RPC servers).

Software AG IDL Extractor for PL/I
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